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Chapter 1

About Connect:Direct for Windows

Connect:Direct for Windows is an enterprise solution for secure, automated file delivery between
business applications. Its session management and extended recover features help assure data
delivery in support of 24 hours a day, 7 days a week business operations.

Connect:Direct for Windows links technologies, moves all types of information, and manages
high-performance transfers by providing easy-to-use automation, checkpoint/restart, and error
recovery. Connect:Direct offers choices in communications protocols, hardware platforms, and
operating systems. It provides the flexibility to move information from mainframes to midrange
systems to desktop and LAN-based workstations.

Using Nodes to Transfer Data

Each data transfer involves a local and a remote node. The active Connect:Direct server is the local
node and the remote node is the partner node. The two servers (local and remote) function together
to perform the work. Either Connect:Direct node initiates the work. You can submit Processes from
a remote node to run on your local Connect:Direct node.

When Connect:Direct establishes a session between the local and a remote node, one is the initiator
of the session and the other serves as the partner and has a secondary function. The node that
initiates the session has primary control, regardless of the direction of information flow.
Connect:Direct must be installed on both the local node and the remote node.
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The following figure illustrates the difference between primary control and local/remote nodes.
Process monitors and statistics reports on the local Windows node show both Processes as they
affect the local system. You can determine if the local node is the initiating or receiving node.

Process 1: A Connect:Direct for Windows user attaches to the server and submits a Process to run
on the Windows node. The Process copies data from the Windows node to the z/OS node. The
Windows node is the local node and has primary control because it initiates the activity.

Local Node Remote Node
) Connect:Direct for Connect:Direct for
Windows -0 2108
Primary Control Secondary Control
(PNODE) (SNODE)

Process 2: A Connect:Direct for z/OS user submits a Process to run on the z/OS node. The Process
copies data from the Connect:Direct for Windows node to the z/OS node. The z/OS node has
primary control because it initiates the activity and is called the PNODE.

Remote Node

Local Node
Connect:Directfor | Connect:Direct ‘L
Windows ----z/0S — .
User
Secondary Control Primary Control
(SNODE) (PNODVE)

Planning to Use Connect:Direct for Windows

Before you use Connect:Direct for Windows, plan how you will use it to perform your work.
Complete the following tasks to use Connect:Direct for Windows:

4 Configure Connect:Direct for Windows
4 Define the work to perform
4 Perform and manage the work that is performed

For most tasks, you can decide the tool to use to create the component. Connect:Direct Requester
is a graphical interface that makes it easy to configure Connect:Direct for Windows and create
Connect:Direct Processes. Because you can use this tool to perform all functions necessary to use
Connect:Direct for Windows, this document provides instructions on using Connect:Direct
Requester to create and submit Connect:Direct Processes, view Process activity and output, and
perform administrative tasks such as editing the network map, modifying initialization parameters,
and defining user authorizations.
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Configuring Connect:Direct for Windows

Before you begin using Connect:Direct for Windows, first configure your environment. To prepare
to use Connect:Direct to submit Processes, perform the following tasks:

4 Configure the Local Node—Configure a local definition for each server you install at the local
site, define a user ID for each user who will access the local node, define user authorities for
each user ID and if remote users need to access the local network, define remote user proxies.
Use Connect:Direct Requester to configure the local node.

When you copy data from a local domain to a domain on a network, the Domain user ID and
password must be the same on both domains and a trust between the two domains must exist.

4 Configure the Network Map—Identifies the remote nodes that each local node can
communicate with and the communications information needed to establish a connection. Use
Connect:Direct Requester or the Configuration tool to configure the network map.

Defining the Work to Perform

After you determine what tasks to perform, you define Processes and work lists. A Process provides
instructions, called statements, for transferring files, running programs, submitting Processes on the
remote node, and altering the sequence of Process step execution. It also controls the execution of
the Process. Use Connect:Direct Requester for Windows to define Processes.

You create Processes and store them in a file for repeated use. You can customize a Process when
you submit it by temporarily changing its controlling parameters (such as the remote node) and by
using symbolic substitution variables. You can submit Processes to any Connect:Direct node. The
local node and a remote node work together to execute the Process.

If you want to define the work but you are not ready to submit it for execution, define a work list.
A work list contains a sequential list of Process submit requests. It can contain ad hoc Processes that
you can submit to the Connect:Direct server: Send/Receive File, Submit Process, Run Task, or Run
Job. Using work lists can save you time and effort by automating routine or repetitive submission
tasks. You can build a work list to periodically submit related work as a single work flow. Your
work list can serve as a library of related or unrelated Processes.

Performing the Work

Once you define the Processes necessary to perform the work, you are ready to transfer files. You
make requests through a computer that accesses the Connect:Direct server across a communications
network. Files that you want to transfer must reside on or be accessible to the server.

The following events occur when you begin the file transfer process:

4 The commands you issue are passed to the appropriate API.

4 The API verifies that they are syntactically correct and contain all the required information to
execute the request. It then packages and ships the commands to the server.

4+ Command processors on the server either execute the commands or pass them on to the server
where the data transfer, statistics management, and other services take place.

4 The Connect:Direct server packages the results of the command and routes them back to the
originating workstation. You can use the management tools to display the results of the
Process.

Use Browser User Interface, Connect:Direct Requester, or the Command Line Interface to control
Processes.
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Managing the Work

As Processes are submitted, the Transmission Control Queue (TCQ) holds information about
Connect:Direct Processes that are currently executing or scheduled to execute in the future. The
TCQ contains four logical queues: Execution, Wait, Timer, and Hold.

Connect:Direct places the Process in the appropriate queue based on Process control parameters that
affect scheduling. Connect:Direct selects Processes in a priority-based manner for execution as
sessions are available.

Connect:Direct for Windows provides tools to allow you to manage Processes. These tools include:

‘

<+

Process Monitor—Use this tool to view Processes in the Transmission Control Queue (TCQ),
release held Processes, change the status of a Process, and delete a Process.

Process Notification Utility—Use this utility to change the notification method you defined
when you installed Connect:Direct for Windows to notify users of Process execution.

Windows Event Logging—Use this utility to log informational, warning, and error messages
that are generated.

Message Lookup—If you need to troubleshoot the meaning of an error message, use this
utility to view more explanation about an error message.

SNMP—If you want to use Microsoft Windows SNMP to capture messages, you must identify
which messages you want to include and determine if messages are trapped or logged to the
event log.

CRC checking—If you want to enable CRC checking, a CRC is generated for the entire buffer,
including the header. The SNODE calculates the CRC value and compares it to the CRC value
in the TCP header. If the values do not match, the Process is terminated. When Secure+ Option
is enabled during a session, CRC checking is disabled.

CLI—The command line interface provides commands to access queues and manage
Processes. These commands enable you to control Process execution, view Process status and
results, and affect the Connect:Direct server. Issue these commands through or in a native
command text format through the Applications Programming Interface (API).

Connect:Direct Browser User Interface—Connect:Direct Browser User Interface allows you
to build, submit, and monitor Connect:Direct Processes from an Internet browser, such as
Microsoft Internet Explorer.

You can also perform Connect:Direct system administration tasks, such as viewing and
changing the network map or initialization parameters, from Connect:Direct Browser. The
specific administration tasks that you can perform depend on the Connect:Direct platform that
your browser is signed on to and your security level.

Connect:Direct Browser is distributed on CD-ROM with Connect:Direct for z/OS,
Connect:Direct for Windows, Connect:Direct for UNIX, Connect:Direct for HP NonStop, and
Sterling Control Center. It can also be downloaded from the Sterling Commerce Web site.
Connect:Direct Browser is installed on a Web server and can be accessed by administrators
and users through a URL. The following example shows the page used to graphically build a
Process:
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glﬁfﬁ'ﬂw Connect:Direct Browser User Interface

- User Functions ! » Admin Functions | Message Lookup i - Help

Process Builder Summary

Eﬁ-Add Statementl Copy "?]- § Tex‘tView-‘ % Export Validate Submit"
Btatement Lahel Description
lEd Frocess COPY102 PROCESS SMNODE=WHT.4100.ALTHA
GEFXE Copy COPY1  COPY PMODE:00000057 datto SNODE:Rec00000057 . dat
GIFXE If Check!  [F {COPY1 Greater than 0}
G X4 Rundob RUMNJOB PHODE DEN=MCOTIFYADM SYSOPTS=
G X& Endlf EIF

To learn more about Connect:Direct Browser, refer to the Connect:Direct Browser
documentation.

4 Transmission Control Queue—Connect:Direct stores submitted Processes in the Transmission
Control Queue (TCQ). The TCQ is divided into four logical queues: Execution, Wait, Timer,
and Hold. Processes are run from the Execution queue. Connect:Direct places a Process in the
appropriate queue based on Process statement parameters, such as the hold, retain, and startt
parameters.

Connect:Direct runs Processes based on their priority and when the Process is placed in the
Execution queue. Higher priority Processes run ahead of Processes with a lower priority. You
can access the queues and manage the Processes through Connect:Direct commands.

4+ File Agent—Connect:Direct File Agent provides unattended file management. File Agent
monitors directories to detect new files. When File Agent detects a new file, it either submits a
default Process or evaluates the file to determine which Process to submit. You create rules to
submit different Processes based on the following properties:

¢ Specific or partial file names
¢ File size
¢ System events

Create Processes used by File Agent on Connect:Direct; you cannot create them using File
Agent.

To achieve optimum performance, configure File Agent to communicate with the
Connect:Direct node where it is installed. File Agent can be installed on UNIX, Windows, and
z/OS. For information, see the Managing Files with Connect:Direct File Agent in the
Connect:Direct for Windows System Guide. The Connect:Direct File Agent Help contains
instructions for configuring File Agent.

4 Sterling Control Center —Centralized management system that provides continuous
enterprise-wide business activity monitoring for Connect:Direct, Connect:Enterprise, and
Gentran Integration Suite (GIS) servers. Sterling Control Center enables you to:

¢ Manage multiple servers—group individual servers to allow a single view of system-wide
activity, view processing status, suspend, release, and handle Connect:Direct Processes,
and stop Connect:Direct servers.
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10

¢ Monitor service levels—Allows you to view processing across Connect:Direct,
Connect:Enterprise, and GIS servers and retrieve information about processing
I [l sterling Cnnrnl Center - localhost 10l =l
File Server Manage Tools Window Help
Servers Groups | - server Status
’@ Control Center i
L 0 L e Mo [ L enerVersl e pivation | Notificati
E‘i augusta3soT H augustalg.. 0 0 0 Lnknown 30 days
1@ | gal60s0i2600 & |gaie0sol3. o 0 0 UNEC3600 [11-01-200... |30 days
(| evigadenz CEIEE 0 WINDOWS . [01-01-2010 |30 days
: (| winbody @ |winbory 200 o 0 WINDOWS ...[01-01-2010 |30 days
i ?—g}g C_onnect:Enterprise (052
i fi':ﬁ ce_galBlibm 4 Uil I
£l ]| ke 300 Ay Active Alerts Monitor - Connect:Direct iz |x]|
l—@ poouni-L |E |@ | F | Filter: Mone (full listing shown)
[# [&] | sewer | DateTime | RuleMName |Process .. |Process D |Evert Type
1 pﬁ svl60dell3  |2006/1 0024 11:... |Bad Return Co... |CCWINSLC 2793 processSte...E
12 '@SWSDdeIIB 200610724 11:... |Bad Return Co... |[COWINRT 2792 processSte..
2 '@SWSDdeIIB 2006/10/24 11:... |Bad Return Co... |COWINRT 2792 processSte.. |
4 '@SWSDdeIIB 200610724 11:... |Bad Return Co.. |CCWINRT 2791 processSte..
L i | ElE |
e Corlet el Aty Mt ConDRCt N e L R B
B [ %] [ 7] Fitter: None duillisting shown) |
[ # [a&alol | sewer [ Mame [ Murnber | Submitter | Returnt
1 @winbody EB127491 5584 admin 0
:2 g}ﬁwinbody E127458 5583 admin 0
;3 5’@ sv160dell3 EB427754 N7 admin 0
4 g}ﬁwinbody E127426 5582 admin 0 |
I 1| m ' E'E
UTC: 2210 | Engine: 17:10 | Local: 17:10 | Preferred: 17:10 l_ admin
* Receive notice if a scheduled events occurs, define rules based on processing criteria
and generate an alert, send e-mail notification, generate a Simple Network
Management Protocol (SNMP) trap to an Enterprise Systems Manager (ESM), run a
system command, or issue a Connect:Direct server command
*  Monitor for alerts, such as a server failure or late-starting Process
* Create service level criteria (SLCs) that define processing schedules, monitor
Processes, files within Processes, and file transfers for compliance with these
schedules, and generate alerts when the schedules are not met
.

Analyze operational metrics to document and analyze processing activity

* Create customized reports based on criteria you define

Authenticate a user logging on to Sterling Control Center, using one of the following

authentication methods: password validation, host name identification, Windows domain,
and TCP/IP address

¢ Identify additional Connect:Direct servers that may need to be monitored based on
communications with a currently monitored server using Guided Node Discovery

Sterling Control Center enhances productivity and improves the quality of service by:

¢ Ensuring that critical processing windows are met

¢ Reducing impact on downstream processing by verifying that expected processing occurs
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¢ Providing proactive notification for at-risk business processes

* (Consolidating information for throughput analysis, capacity planning, post-processing
operational or security audits, and workload analysis

¢ Reducing the risk of errors associated with manual system administration, including
eliminating individual server logon to view activity, and the need to separately configure
each server for error and exception notifications

Sterling Control Center can be purchased as a separate product. Contact your Sterling
Commerce representative to learn more.

Restarting Processes

Several facilities are provided for Process recovery after a system malfunction. Process recovery
allows you to resume execution as quickly as possible and minimize redundant data transmission
after a system failure. The following Connect:Direct facilities enable Process recovery:

4 Process step restart—As a Process runs, the steps are recorded in the TCQ. If a Process is
interrupted for any reason, the Process is held in the TCQ. When you release the Process to
continue running, the Process automatically begins at the step where it halted.

4 Automatic session retry—Two sets of connection retry parameters are defined in the remote
node information record of the network map file: short-term and long-term. If you do not
specify a value for these parameters in the remote node information record, default values are
used from the local.node entry of the network map file. The short-term parameters allow
immediate retry attempts. Long-term parameters are used after all short-term retries are
attempted. Long-term attempts assume the connection problem cannot be fixed quickly and
retry attempts occur after a longer time period, to save the overhead of connection retry
attempts.

4 Checkpoint/restart—This feature is available with both the copy statement and the run task
statement. To activate the checkpoint/restart feature in the run task statement, specify a
restart=yes parameter in the initialization parameters file.

Connect:Direct records the file positioning checkpoint information in the checkpoint/restart
file at specified intervals during a copy operation. If a copy step is interrupted for any reason,
it can be restarted at the last checkpoint position. You can code the restart parameter on the
run task step or in the runtask.parms record in the initialization parameters file. If you add
the restart parameter on the run task step, it overrides the initialization parameter. When you
add restart=yes, Connect:Direct runs the program again. When you code restart=no, the
Process skips the run task step when the Process is restarted. Both the PNODE and the
SNODE must support checkpoint/restart.

4+ Intelligent session restart—When an error occurs on a node connection and multiple Processes
are scheduled for the node, this feature permits a session retry on only the first Process
submitted. The session retry is attempted on the first Process while all other Processes are
placed in the Timer queue. After a session is established for the first Process, the other
Processes are released so that they can be executed.

If a connection is lost during Process execution, one Process is placed in the Timer queue in
RE or retry status using the short and long-term connection retry wait intervals and retry

Connect:Direct for Windows Getting Started Guide 11



Chapter 1 About Connect:Direct for Windows

counts. All other Processes that are executing on the node terminate and are placed in the
Timer queue with RE status.

If a Process is submitted to a Connect:Direct node for which a session cannot be established,
the Process is placed on the Timer queue. Any session retry attempt that is already underway
will continue. If all attempts have already been exhausted, then nothing else is done.

If a connection to a remote Connect:Direct node is reestablished, the Process is restarted and
establishes a connection with the remote node. The SMGR notifies the PMGR that a session
has been established. Each Process in the TCQ Timer queue for this node is released,
scheduled, and executed according to Process priority and session class.

If a connection cannot be reestablished with the remote node, all Processes for the remote node
are placed in the Hold queue in HE (hold due to error) status.

4 Short-term and long-term retry parameter definitions—Enables a Process, which could not run
because a file that it called was unavailable, to be retried at a later time. If a file allocation
error occurs when a Process is executing on either the local or the remote node, and the file
allocation error is identified as a condition to retry, the Process is placed in the Timer queue.
The Process is then retried using the short-term and long-term retry parameter definitions.

Connect:Direct for Windows Documentation

See Connect:Direct for Windows Version 4.4.01 Release Notes for a complete list of the product
documentation.

About This Guide

Connect:Direct for Windows Getting Started Guide is for programmers and network operations
staff who install, configure, and maintain the Connect:Direct for Windows version 4.4 product.

This guide assumes knowledge of the Windows operating system, including its applications,
network, and environment. If you are not familiar with the Windows operating system, refer to the
Windows library of manuals.

Task Overview

12

The following table identifies the information required to perform the tasks in this guide:

Task For More Information, See

Preparing to install Connect:Direct for Windows Chapter 2, Preparing for the Installation

Installing Connect:Direct for Windows Chapter 3, Installing Connect:Direct for Windows

Uninstalling Connect:Direct for Windows Chapter 3, Installing Connect:Direct for Windows

Automating product installation Chapter 4, Automating Connect:Direct for Windows
Installations
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Chapter 2

Preparing for the Installation

Before you install Connect:Direct for Windows, make sure that all system hardware and software,
including third-party software, are configured. Perform the following pre-installation tasks:

4

SRR R

Make sure that the system meets product hardware and software requirements
Define users for Windows

Configure and test TCP/IP or SNA connectivity, if necessary

Install and configure SQL Server for database support, if necessary

Install and configure SNMP, if necessary

If you use NT Broadcast to send user notification messages, ensure that NT Broadcast is
configured

Complete installation worksheets

Product Requirements

Connect:Direct for Windows requires certain hardware and software. Refer to the Connect:Direct
for Windows Release Notes Version 4.4.01 for product hardware and software requirements.

Requirements for Copying Files to and from Network Servers

When you are ready to create Processes, Connect:Direct allows you to share information across
computers. All data does not have to be located on the Connect:Direct server. Observe the following
requirements to enable copying files among network servers:

‘
‘

Files to copy must reside on a file server can be accessed by Connect:Direct for Windows.

You must provide a valid user ID and password for the file server where the files reside. Use a
local node ID when you submit a Process on the local node; use a remote node ID when you
submit a Process on a remote node. You can supply the information as part of the Process
statement or the submit command or use the Login Connection Utility.

Connect:Direct for Windows Getting Started Guide 13
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4 If a Process has multiple copy steps, the local or remote node ID parameter must be
appropriate for each file server from which, or to which you transfer a file because the
parameters apply to the Process as a whole and not to individual copy steps.

4 Specify the Universal Naming Convention (UNC) form of the file name if the file is not on a
drive directly connected to the same Windows server as Connect:Direct. If the file is on the
Windows server where Connect:Direct is installed, you can specify the drive letter.

The UNC name format is as follows:

\\servername\share point name\filename

4 servername—name of the Windows server where data resides.

4 share point name—name under which the remote Windows server shares the directory you
want to access.

4 filename—name of the file and any subdirectories, if necessary.

Configuring Windows User Privileges

Connect:Direct for Windows must be installed by a Windows administrator (for example,
sysadmin). However, the ongoing administration of Connect:Direct for Windows requires only that
the administrator be a member of the Windows users group and defined in the Connect:Direct for
Windows User Authorities with administrative privileges based on the admin template.

After Connect:Direct for Windows is installed, attach to Connect:Direct for Windows as sysadmin
and add users as Connect:Direct for Windows administrator (for example, cdadmin) with the user
right, “Log on locally.” Then, delete sysadmin from the Connect:Direct for Windows User
Authorities.

Refer to the Microsoft Windows system documentation to set up an administrator account. Refer to
Connect:Direct for Windows System Guide to configure User Authorities.

Customizing a Connect:Direct Log On Account

14

Connect:Direct for Windows is installed under the Local System account.

Caution: Enabling Allow service to interact with desktop when running Connect:Direct under the local
System account is a security risk and may allow a user access to services that interact with the
desktop.

To create a custom account for Connect:Direct, assign this account the following privileges:

4 Log on as service—Allows a Windows service to run in the context of the specified user
instead of in the context of the local system account.
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4 Replace a process level token—Allows Connect:Direct for Windows to submit Processes on
behalf of logged on users.

4 Be a member of the Local Administrator Group—To allow the node to update its entry in
Active Directory, the account must also be a member of the Enterprise Admin group.

4 Secure+ directory—Gives the account full permissions to the Secure+ directory.

Note: These privileges are stored locally, even if the computer is a member of a domain. As a result,
privileges cannot be set on the domain controller and granted to all computers on the domain.

Once you create the account, assign it as the account for Connect:Direct. To identify the custom log

on account:

1. Select Start > Settings > Control Panel > Administrative Tools > Services.

2. Double-click the Connect:Direct server.

3. Click the Log On tab.

4. Select This account to identify the custom log on account.

5. Type the account name to use for logging on to Connect:Direct, or click Browse and

double-click the user account to use.

a

Type the password on the Password box and confirm it in the Confirm password box.
7. Click OK.

Configuring Connectivity

Before you install Connect:Direct for Windows, configure connectivity for the TCP/IP or SNA
environment.

TCP/IP Connectivity

To enable TCP/IP connectivity, configure each computer with a valid IP address, IP subnet, and IP
gateway. If the communications partner is on another subnet or network and a firewall is between
the communications partner and the Windows computer, verify that the Access Control Lists
(ACLs) are correctly configured. Contact your firewall or security administrator for more
information on configuring the ACLs for your firewall.

SNA Connectivity

If you plan to use SNA network communications connectivity with Connect:Direct for Windows,
install and configure the SNA software before installing Connect:Direct for Windows. Use the
worksheet, SNA Configuration Worksheet on page 37 to identify the parameters necessary to
configure SNA.
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In addition, create an active connection between the local and remote nodes. Connect:Direct for
Windows requires the following information for the local and remote SNA networks in order to
configure a peer- or host-based partner SNA connection:

Network name

Mode name (local system only)
Control point name

Node ID

Network address (remote system only)

+ e+

LU name and LU alias name (these names may be the same value; Connect:Direct uses the LU
alias name)

Note: Connect:Direct for Windows supports only independent LU6.2.

Refer to the SNA Server/Host Configuration Worksheet on page 38 when mapping SNA connection
parameters between Connect:Direct for Windows and a host system.

Note: Consult the SNA product documentation or contact your SNA vendor for any questions about
configuring the SNA communications software.

The Connect:Direct Workstation Online Connectivity tool is an SNA configuration tool available
on the Connect Support Website at http.//www.sterlingcommerce.com from the Connect Support
> Connect:Direct for Windows > Connectivity section. This tool generates sample SNA
configuration information to assist you in configuring your SNA software and configuring
Connect:Direct for SNA connectivity. The Connect:Direct Workstation Online Connectivity tool
only generates example independent LU6.2 Token Ring SNA configurations at this time. Refer to
the Connect: Direct for Windows Version Release Notes for more information about accessing the
Connect Support Website.

Installing and Configuring Database Software

16

The database logs Process statistics information, internal messages, and the Process control queue.
Determine which software to use as the database software and, if necessary, install the software on
the local computer, or a network drive or remote computer that is accessible from the locally
installed Connect:Direct node.

Connect:Direct supports SQL Server Express and SQL server. SQL Server Express is provided with
Connect:Direct for Windows and can be installed from the media. SQL Server must be downloaded
and installed. If you plan to use Microsoft SQL Server as the database, set the SQL Server to start
automatically in the Services option of the Control Panel.
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Automating the Connect:Direct for Windows Installation

You can automate the installations using an initialization (INI) file. Implement automated
installations by specifying a path to the INI file from the command line of the Windows setup. See
Chapter 4, Automating Connect:Direct for Windows Installations, for information.

Completing the Connect:Direct Worksheets

To prepare for the installation, gather the information you need before you begin. Record
installation information in Connect:Direct for Windows Installation Worksheet on page 35. After
you complete the installation worksheet, use it as a guide to install Connect:Direct for Windows.

Complete the following worksheets:

4 The Connect:Direct for Windows Installation Worksheet on page 35 to identify settings
necessary for a basic installation.

4 The SNA Configuration Worksheet on page 37, if you plan to configure SNA software.

4 The SNA Server/Host Configuration Worksheet on page 38, if you plan to set up and configure
an SNA connection between the host and the SNA server.
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Installing Connect:Direct for Windows

Once you complete the installation worksheets, you are ready to install Connect:Direct for
Windows.

When you perform the installation, you can install all Connect:Direct for Windows components or
you can install selected components. Choose from the following components:

4 Connect:Direct for Windows server—Performs the functions issued from the user interface. If
you want a dedicated server, install only this component. It also includes the Command Line
Interface (CLI), a tool that allows you to issue commands to the server.

4 Connect:Direct for Windows Requester—A graphical user interface that makes it easy to
configure Connect:Direct, create Processes, and submit commands to the server.

4 Connect:Direct File Agent—A component that scans directories for the appearance of files.
When a file is detected, Connect:Direct either submits a default Process to Connect:Direct or
performs the actions specified by the rules. For more information, see Managing Files Using
Connect:Direct File Agent in the Connect:Direct for Windows System Guide.

4 Connect:Direct Secure+ Option—A separately purchased option that allows you to implement
security into a Connect:Direct operation. Secure+ must be installed on both nodes to activate
the security software.

4+ Software Developer’s Kit (SDK)—A separately purchased option that allows programmers to
customize the functions of Connect:Direct for Windows.

After you install Connect:Direct for Windows, TCP/IP information, database information, and
notification method is defined in the initialization parameters. To change TCP/IP information,
notification type, or the database, refer to Connect:Direct for Windows System Guide.

About the Connect:Direct for Windows Installation

Before you begin the installation, choose the installation type to meet your needs. For example, to
install a standalone server, install only the Connect:Direct for Windows server software. To use a
computer as a server and a workstation, install both the server software and Connect:Direct
Requester. If you purchase Secure+ Option, use the custom installation to install both
Connect:Direct for Windows and Secure+ Option.

Additionally, if you have a large network of computers where you need to install Connect:Direct
for Windows, you can set up a silent installation. To configure a silent installation, install
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Connect:Direct for Windows on one computer. Then use the initialization parameters file created
during the installation to create a silent installation. Send the modified INI file to each computer on
which to perform the silent installation.

Icons illustrate the selected installation type. The following table shows the icons and installation
types:

Icon Description

The component is installed to the local drive.

Selected features of the component are installed.

The component is not installed.

Adds an icon to the desktop of the selected computer. The component is only installed
when the user clicks the program icon to run the program.

pixER

The component is installed on the network.

'

Connect:Direct is installed in the C:\Program Files\Sterling Commerce\Connect:Direct
v4.4.01\component directory, where component is the component being installed. To install
Connect:Direct for Windows in another location, select Custom setup and click Change in the setup
panel. The remaining procedures use the default installation path.

Installing a Temporary or Permanent License Key File

20

The temporary and permanent license key file must be applied on the computer where
Connect:Direct for Windows is installed.

To apply the temporary or permanent key file:

1. Copy the temporary license to C:\Program Files\Sterling Commerce\Connect Direct
v4.4.01\server.

2. Rename the temporary key file to license.key.

Caution: Do not edit the nnnnn.txt file or the license.key file. Text editors may insert a carriage return
or truncate lines, which will invalidate the key file.

3. To obtain a permanent key, run the CD System ID Utility. To run the CD System ID Ultility:

a. Click Start>Programs>Sterling Commerce Connect:Directv4.4.01>CD System ID
Utility. The main window displays the CPU-ID and number of processors.

b. To save the information, click File>Save.
Type a name for the file and click Save.
d. Click File>Send email.
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e. Type requested information in the e-mail template and click Send.
You receive the permanent license key by e-mail in approximately 24 to 48 hours.
Make a copy of the key and keep it in a safe place.

To replace the temporary license key with the permanent one, copy the license to C:\Program
Files\Sterling Commerce\Connect Direct v4.4.01\server. Rename it to license.key.

Installing Connect:Direct Server and Requester

To perform the Connect:Direct for Windows typical installation:

L.

Al

Insert the Connect:Direct for Windows CD into the CD-ROM drive or double-click the
setup.exe file extracted from the file downloaded from ESD Portal. If the Autorun option is
enabled, the installation automatically starts. I[f Autorun is disabled, start the program from the
Run dialog box.

On the Welcome dialog, click Next.
Select Typical and click Next.
On the Configure dialog select Default to use the default settings for the server. Click Next.

On the License Management dialog box, click Browse and locate the license file you
received from Sterling Commerce. Click Next.

The file is copied to C:\Program Files\Sterling Commerce\Connect:Direct v4.4.01\server.
On the Configure SQL Server dialog box, do the following and click Next.
a. Select the SQL server to use with Connect:Direct.
b. Select one of the following authentication methods for the connection:
*  Windows authentication credentials of current user

» Server authentication. If you select this method, type the user ID and password to use
for authentication.

From the Ready to Install the Program dialog box, click Install.

If you do not want to start the Requester when the installation is complete, deselect Launch
Connect:Direct Requester.

Click Finish.

Installing Connect:Direct for Windows and Secure+ Option

Use this option to install Secure+ Option at the same time that you install Connect:Direct and
Requester.

To perform a custom installation:
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10.

I1.

12.

13.

Insert the Connect:Direct for Windows CD into the CD-ROM drive or double-click the
setup.exe file extracted from the file downloaded from ESD Portal.

If Autorun is enabled, the installation automatically starts. If Autorun is disabled, start the
program from the Run dialog box.

On the Welcome dialog, click Next.
To install Secure+ Option as you install Connect:Direct, select Custom. Click Next.

To install Secure+ Option, click the icon next to Secure+ and identify the type of installation
to perform. Click Next.

The default installation path for Connect:Direct for Windows is C:\Program Files\Sterling
Commerce\Connect Direct v.4.4.01. To change the path, click Change. Choose the
destination location and click OK.

If you install Secure+ Option, read the message and click Next.

On the Configure Connect:Direct for Windows Server dialog, select Custom and click
Next.

The name of the computer where you are installing Connect:Direct for Windows is displayed.
To use a different local node name, type the name in the field provided and click Next.

The License Management dialog box is displayed. Click Browse and select the license file
provided by Sterling Commerce and click Next.

The license file is copied to the C:\Program Files\Sterling Commerce\Connect Direct
v4.4.01\server folder.

On the Configure SQL Server dialog box, do the following and click Next.
a. Select the SQL server to use with Connect:Direct.
b. Select one of the following authentication methods for the connection:

*  Windows authentication credentials of current user

*  Server authentication. If you select this method, type the user ID and password to use
for authentication.

On the Service Account Information dialog box, the privileges of the Local system account
are displayed. To specify a different account, type:

¢ Service Account name
¢ Service Password
¢ Verity the password

To configure TCP/IP as the connection method, type or select the following information and
click Next:

¢ Node-to-Node IP Address
¢  Node-to-Node Port
¢ User Interface IP Address

¢ User Interface Port
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15.

16.

17.

18.

19.
20.

Upgrading Connect:Direct for Windows

If you installed SNA, configure SNA support:

a. Select Configure SNA.

b. Type the local LU name in the Local LU Name field.

c. Type the network name or ID in the Network Name (NET ID) field.
d. Type the mode name in the APPC Mode Name field.

e. Click Next.

To use Active Directory, select Register Client Connection Settings and click Next on the
Register with Active Directory dialog box.

To configure SNMP support, enable one or more of the following features and click Next:

a. Select Enable Connect:Direct SNMP Extension Agent to enable the SNMP extension
agent.

b. To enable event logging, select Enable SNMP Event Logging.

To configure notification support, select one of the following options and click Next:
¢ To enable Windows broadcasting, select NT Network Broadcast.

¢ To enable SMTP, select SMTP.

To use a network map or user authorities from previous versions of Connect:Direct, click
Browse and select the network map or user authority configuration file to import. Click Next.

Click Install. A message informs you that Connect:Direct for Windows is being installed.
Click Finish.

Upgrading Connect:Direct for Windows

To upgrade a previous installation of Connect:Direct:

1.

S i

Insert the Connect:Direct for Windows CD into the CD-ROM drive or double-click the
setup.exe file extracted from ESD Portal. If Autorun is enabled, the installation automatically
starts. If Autorun is disabled, start the program from the Run dialog box.

On the Welcome dialog, click Next.

Select Typical and click Next.

On the Configure dialog select Upgrade and click Next.

Select a node to upgrade in the Installed Nodes drop down box and click Next.
To keep the previous installation, enable Keep previous version and click Next.
Click Install.

The Finish dialog box has a check box to automatically start Connect:Direct Requester. If you
do not want to start Connect:Direct Requester, deselect this option. Click Finish.
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Modifying, Repairing, and Installing Connect:Direct for
Windows Components

After you install Connect:Direct for Windows, you can change the features including repairing a
component that is corrupt, removing a component, or installing an additional component. After you
install Connect:Direct, future installations identify this as a second installation.

To add, remove, or repair a Connect:Direct component:

1. Insert the Connect:Direct for Windows CD into the CD-ROM drive or double-click the
setup.exe file extracted from ESD Portal. If Autorun is enabled, the installation automatically
starts. If Autorun is disabled, start the program from the Run dialog box.

2. On the Welcome dialog, click Next.
To install additional Connect:Direct for Windows components:
a. Select Modify and click Next.
b. Click Next.
c. Select the components to modify and click Next.
d. Click Install.
e. Click Finish.
4. To repair an installed Connect:Direct for Windows component:
a. Select Repair.
b. Click Next.
c. Select the components to modify and click Next.
d. Click Install.
e. Click Finish to complete the repair.
5. To remove an installed Connect:Direct for Windows component:
a. Select Remove to uninstall a Connect:Direct component.
b. Select the components to modify and click Next.
c. Click Next.

&~

Click Remove.

e. Click Finish after the components have been removed.

Installing Connect:Direct File Agent

When you install Connect:Direct File Agent, Java Runtime Environment (JRE) is automatically
installed. To install File Agent:
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1. Insert the Connect:Direct for Windows CD into the CD-ROM drive or locate the files you
extracted from ESD Portal, and double-click the FileAgentInstall.exe.

From the Introduction dialog box, click Next.
To install File Agent in a selected location, click Choose and identify the location.

Click Next, then click Install.

wokh N

When the installation is complete, click Done.

Uninstalling Connect:Direct for Windows

The Connect:Direct for Windows Uninstall program removes the application, its components,
Connect:Direct Requester and Connect:Direct for Windows server, and program folder.

To uninstall Connect:Direct Server and all of the server utilities:

Click Start/Programs/Settings/Control Panel/Add-Remove Programs.
Highlight Connect:Direct for Windows and click Remove.

Click Yes to confirm the removal.

Click Finish.

Click OK to close the Add/Remove Programs Properties dialog box.

A e

Adding Initialization Parameters to Support Firewall
Navigation

If you communicate with a trading partner using a firewall, set two initialization parameters to
support it. You assign a specific TCP/IP source port number or a range of port numbers with a
particular TCP/IP address or addresses for outgoing Connect:Direct sessions. Setting these
parameters allows controlled access to a Connect:Direct server if it is behind a packet-filtering
firewall without compromising security.

To implement the firewall navigation:
1. Coordinate IP addresses and associated port assignments with your firewall administrator.

2. Add the following parameter to the Local Node Characteristics section of the initialization
parameters file:

tecp.src.ports=(valid IP address/optional subnet mask | valid IP address pattern,
associated port number / associated range of port numbers / associated port
number, associated range of port numbers)

3. Apply the new initialization parameter.

A second parameter called tcp.src.ports.list.iterations is automatically added to the Local Node

Characteristics section during installation and has a default value of 1.

Connect:Direct for Windows Getting Started Guide
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Refer to the following table for a description and valid values for these parameters:

Parameter Name

Parameter Definition

Valid Values

tcp.sre.ports

IP address or multiple
addresses and the ports
permitted for the address
when going through a
packet-filtering firewall.

Valid IP address with an optional mask for
the upper boundary of the IP address
range and the associated outgoing port
number or range of port numbers for the
specified IP address, for example:

(199.2.4.*, 1000), (fd00:0:0:2015:*::*,
2000-3000), (199.2.4.0/255.255.255.0,
4000-5000),(fd00:0:0:2015::0/48, 6000,
7000)

For more information on IP addresses,
masks, and ports, see the Specifying IP
Addresses, Host Names, and Ports
appendix in the Connect:Direct for
Windows System Guide.

A wildcard character (*) is supported to
define an IP address pattern. If the
wildcard character is used, the optional
mask is not valid.

tep.sre.ports.list.iterations

Specifies the number of times
that Connect:Direct scans the
list of available ports defined
in tcp.src.ports to attempt a
connection before going into a
retry state.

This parameter is
automatically added to the
initialization parameter and is
assigned a value of 1. If
desired, change this value.

A numeric value from 1-255. The default
value is 1.

4. Coordinate the specified port numbers with the firewall administrators.

Firewall Configuration Example

The following sample illustrates a configuration of the firewall navigation initialization parameter.
An explanation of the configuration follows the example. Although the tcp.src.port parameter is
shown as a multi-line parameter in the following example, Connect:Direct for Windows only
supports single-line parameters.

tcp.src.ports=(199.2.4.*, 5000-5050),

(199.2.4.7, 1376),
(200.200.0.0/255.255.0.0, 2000-2100, 3000-3100),
(138.16.17.*, 2000-2050, 3000-3050, 4001, 4005)
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In this example, if Connect:Direct initiates a session with a remote node at the IP address 199.2.4.7,
it will use only port 1376. A session 199.2.4.6 (or any other address beginning with 199.2.4) will
use any port in the range 5000 to 5050.

A session to 200.200.4.10 uses a port from within the two ranges specified (2000 to 2100 or 3000
to 3100.) Additionally, because of the subnet mask specification, a session to any IP address
beginning with 200.200 will choose a port from within the two ranges specified.

The port for a session to any address beginning with 138.16.17 is selected from one of the two
ranges (2000 to 2050 or 3000 to 3050) or the two individual ports specified (4001 or 4005).
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Automating Connect:Direct for Windows
Installations

About Silent Installations

You can automate Connect:Direct for Windows installation and configuration for distribution
throughout your enterprise by performing silent installations. Silent installations require no user
responses during the installation routine. Configuration information is supplied by the initialization
file that you define. Before you perform a silent installation, install Connect:Direct for Windows on
a master node and configure a network map and user authorizations.

The Microsoft Installer Properties are the foundation of a silent installation. Properties can be set
on the command line or by creating custom transforms. A transform is a collection of changes
applied to an installation.

Transforms alter the installation database and can be used to customize a base installation package.
Applying a transform to a base installation package adds or replaces data in the installation
database.

Silent Installation Options

You can perform a default silent installation to install Connect:Direct server and Connect:Direct
Requester, or you can use transforms to modify the settings of an installation package. The
transforms included with this product enable, disable, and remove a feature from the Connect Direct
for Windows.msi package. To change the silent installation setting, use a transform to enable or
disable the desired feature.

Requirements for Silent Installation
Use the following list as a guide to the silent installation requirements for each node:

4 To perform the default installation (server and Connect:Direct Requester), the node must have
a license key.

4 To install only Connect:Direct Requester or SDK, no license key is required.

4 Ifthe node uses special services, for example, Active Directory, SNMP, or SNA, a custom INI
file is required. If no custom INI file is present, the default installation is performed.
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Customize Initialization Information for a Silent Installation

The Connect:Direct server supports an INI file, which can specify the value of installation
properties. If you plan to use the INI file to manage a silent installation, change the parameters of
the INI file provided with Connect:Direct for Windows to specify site-specific information.

The Connect:Direct for Windows server initialization file (CD_SRVR.INI) is located on the CD in
the /advanced folder. The Connect:Direct Requester and SDK installations do not use initialization
files. To set the installation directory for an installation, specify the INSTALLDIR property in the

command line.

To define site-specific parameter values in an INI file for each node where you install
Connect:Direct for Windows using the silent installation, do the following:

1. Open the CD_SRVR.INI file using any text editor, such as Windows Notepad.

2. Define the site-specific initialization parameters for a node and save the file.

3. Repeat steps 1-2 for each server where Connect:Direct will be installed.

CD_SRVR.INI Parameter Values

Refer to the following table for available parameters defined in the CD SRVR.INI file:

Parameter Name

Parameter Definition

Values

CD_SETUP_TYPE

The installation type: Default,
Custom, or Upgrade.

Default | Custom | Upgrade

CD_SQL_AUTHENTICATION

SQL Authentication

CD_SQL_USERID

Service account name to log on
with.

CD_SQL_PWD

Password to log on with.

CD_NODENAME

Local node name, from 1-16
characters, including numbers,
letters, @, #, $, -, underscore
(L), and period (.).

If blank, the parameter defaults
to the first 16 characters of the
computer where the server is
being installed.

CD_UPGRADE_NODE

The version of software and
node to upgrade.

Version of software to update
and the name of the node in the
format Vx.xx.xx\nodename
where x.x.xx is the version
number

CD_UPGRADE_KEEPSCR_FLAG

Prevents the current version
from being deleted before
installing the new version.

1=enabled

This variable applies only if
CD_SETUP_TYPE=Upgrade
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Parameter Name

Parameter Definition

Values

CD_LICENSE_FILE

Path name to the license file
(license management key.)

X:\Program Files\Sterling
Commerce\Connect Direct
\v4.4.01 | Any valid Windows
directory

CD_HOST_IP

IP address of the host server.

Any valid IP address.

CD_HOST_PORT

Port number the Connect:Direct
Windows, or user-written API
programs will use to establish
client sessions with the
Connect:Direct server for
outgoing communications.

A numeric value in the format
nnnn, where nnnn is a positive
integer with a value from
0-65535. The default is 1364.

CD_APL_IP Host IP address. Any valid Valid TCP/IP address. If blank,
TCP/IP address may be the IP is obtained from the
specified. destination computer’s IP

address in the TCP/IP stack.

CD_API_PORT Port number that A numeric value in the format
Connect:Direct for Windows or  nnnn, where nnnn is a positive
API| program uses to establish  integer with a value from
client sessions with this 0-65535. The default is 1363.
Connect:Direct server. Specify
the port when it differs from the
default.

CD_SNA FLAG Indicates whether SNA 1=enabled

connectivity is supported.

CD_SNA_LUNAME

Local LU name to use during
SNA communications or the
name of the computer, if no LU
name is specified.

Valid 1-8 character LU name or
computer name up to 8
characters.

CD_SNA_NETID

The SNA network ID.

A valid 1-8 character network ID

CD_SNA_MODE

The SNA mode name.

ndm624K | a valid 1-8 character
mode name

CD_SNMP_FLAG Enables SNMP. 1=enabled
CD_EVENTLOG_FLAG Enables SNMP Event log. 1=enabled
CD_ACTIVEDIR_FLAG Registers the client IP address  1=enabled

to active directory.

CD_NOTIFY_TYPE

Notification type to use.

NT Broadcast | SMTP

CD_NOTIFY_SMTP_HOST

If CD_NOTIFY_TYPE = SMTP,
this field identifies the IP
address of the SMTP host.

Host address in the format
nnn.nnn.nnn

CD_NOTIFY_SMTP_PORT

If CD_NOTIFY_TYPE = SMTP,
this field identifies the port used
by the SMTP host.

Port number up to four
characters.

Default=25.
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Parameter Name

Parameter Definition

Values

CD_NOTIFY_SMTP_SENDER

If CD_NOTIFY_TYPE = SMTP, this
field identifies the e-mail
address to identify the sender of
the message

Valid e-mail address

CD_NOTIFY_SMTP_AUTHENTICATE

If CD_NOTIFY_TYPE = SMTP, this
field enables authentication. If
this value is not set, the user ID
and password are ignored.

1 = enabled

CD_NOTIFY_SMTP_USERID

If CD_NOTIFY_TYPE = SMTP, this
field identifies the user ID to use
to authenticate the server.

A valid user ID.

CD_NOTIFY_SMTP_PWD

If CD_NOTIFY_TYPE = SMTP, this
field identifies the password to
use to authenticate the server.

A valid user password.

CD_USERAUTH_FILE

Path and file name to the user
authority file.

X:\Program Files\Sterling
Commerce\Connect Direct
\v4.4.01\
MyUserAuthSettings.cfg | Any
valid Windows directory and
user authority file name

CD_NETMAP_FILE

Path and file name of the
network map file.

X:\Program Files\Sterling
Commerce\Connect Direct
\v4.4.01\mynetmap.map | Any
valid Windows directory and
network map file name

CD_SVC_ACCOUNT

Service user account.

CD_SVC_ACCOUNT_PWD

Service user password.

CD_SQL_SERVER

Name of a valid SQL server.

Valid SQL Server

CD_SQL_AUTHENTICATION

SQL authentication.

CD_SQL USERID

SQL Server system
administrator’s user ID.

Valid SQL Server System
administrator user ID

CcD_SQL_PWD

SQL Server system
administrator’s password.

Valid 1-30 character SQL
Server System administrator
password

Customize Connect:Direct for Windows Configuration

After you install Connect:Direct for Windows on a master node, you can customize configuration
information for distribution within your enterprise by using Connect:Direct Requester to configure
the network map and user authorizations on the master node. You can then extract those files using
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the Configuration Utility. For more information about using the Configuration Utility, refer to
"Defining and Managing the Connect:Direct Network" in Help or in the Connect: Direct for
Windows System Guide.

To apply the customized configuration files during a silent installation, set parameter values in the
CD_SRVR.INI file as follows:

4 To apply a customized network map file, set CD_NETMAP_FILE to the fully qualified path
to a customized
4 network map configuration file.

4+ To apply a customized user authorization file, set CD_USERAUTH_FILE to the fully
qualified path to a customized User Authorization configuration file.

Run

a Silent Installation

Setup.exe installs the Microsoft Installer, Visual C++ Runtime Libraries and other prerequisites on
a system when they do not already exist. To complete the installation, Setup.exe reboots the system
if required and resumes the installation after the computer has restarted.

Setup.exe can accept a limited number of command-line parameters. By using these parameters,
you can pass parameters through Setup.exe to the included .msi file (MsiExec). To pass arguments
to the .msi file, use the /v option. Once you specify this option, you can list any of the supported
parameters that can be passed to Msiexec.exe.

If you don't want the Setup.exe to display a progress bar when it launches, use the /s command-line
parameter. For example, if you enter Setup.exe /s, Setup.exe launches, but the user interface is not
displayed. If you want the .msi setup to run silently as well, you'll need to pass the /qn
command-line parameter through Setup.exe using the /v parameter—for example: Setup.exe /s
/v/qn

Follow these special formatting rules when passing a parameter in this way. First, place a backslash
(\) character before a quotation mark that resides within existing quotes. For example, the command
line above contains the following: /v"C:\My Files\SecurePlusEnable.mst\". Because the path
contains spaces, you must use quotes.However, since quotes are required around the complete
argument, if you don't use the backslash before internal quotes, the command-line statement fails.

Do not put a space between the command-line option (/v) and the arguments you are passing. This
rule is also illustrated in the above example.

Finally, if you are passing multiple parameters using the /v option, separate them with a space. For
example, the following command enables Secure+ Option and specifies the license file:

Setup.exe /s /v"C:\My Files\SecurePlusEnable.mst\" CD LICENSE FILE=\"C:\My
Files\license.key\""

To attach to the network and install Connect:Direct for Windows features from the network location
in a silent installation:

1. Click Start > Run. The Run dialog box is displayed.

2. In the Open field of the Run dialog box, type a command similar to following example:
Setup.exe /s /v/qn
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This command installs all Connect:Direct for Windows components including Connect:Direct
Requester and Secure+ Option.

Note: Setup.exe installs Connect:Direct for Windows in the default directory c:\Program
Files\Sterling Commerce\Connect Direct Windows v[current version]. If you want to install
Connect:Direct for Windows in a different directory, use the INSTALLDIR option on the
command line. Enclose the pathname in quotes and terminate the path with a backslash,
such as Setup.exe /v'INSTALLDIR=\"D:\Program Files\Sterling Commerce\Connect
Direct v4.5.01\"" .

3. Computers in a Windows 2000 or XP Domain that use Active Directory can also automate
installations using the software installation extension of the Group Policy Snap-In.

The Windows installer uses an /M command line parameter to generate MIF files. In the
following example, the CDNT.mif file is created to report success or failure: setup.exe /s /v/qn
/M C:\Windows\CDNT.mif
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Worksheets

Use the worksheets in this appendix to gather and record information needed for the installation.

Connect:Direct for Windows Installation Worksheet

Complete this worksheet before you install Connect:Direct for Windows.

1.

What Connect:Direct software do you plan to install?

Q Connect:Direct Requester

Q Connect:Direct Server

Q Connect:Direct Secure+ Option

Choose the installation directory, where X represents the drive mapped to your Windows

directory.

Q  Accept the default installation directory - C:\Program Files\Sterling Commerce\Connect:Direct
v4.4.01

Change the installation directory

New installation directory:

a
a
O Install on a network drive
a

Place an icon on a desktop to install Connect:Direct the first time the application is opened.

Name the Connect:Direct node—Default local node name is the name of the Windows
computer.

Local node name:

Note: To change the local node name after the product is installed, you must re-install Connect:Direct
for Windows.

Identify the location of the license management file.

License file location:

Maximum number of sessions:
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5. Identify the database software:

a

SQL Server Express

Q Microsoft SQL Server—Windows Authentication
If SQL security is implemented, create a valid user ID and password and a CREATE TABLE

privilege within the database.

SQL Server Name:

User ID: Password:

SQL Server with Mixed Mode Authentication

If Integrated security is implemented, make sure the user group that the Connect:Direct installer
belongs to has CREATE TABLE privilege in the Connect:Direct database.

SQL Server Name:

6. Identify TCP/IP communication information.

Node-to-Node IP Address:

Node-to-Node Port:

User Interface IP Address:

User Interface Port:

7. Identify additional components, as necessary:

a

O

APPC Connectivity - SNA
LU Name:

Net ID:

Mode Name

Process Notification
NT Broadcast
SMTP

SMTP Settings:
Host Address:

Host port:

Default=25

Sender:

Load an Existing Network Map
Fully-qualified pathname for the MAP.CFG:

Load Existing User Authorities
Fully-qualified pathname for the USER.CFG:
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SNA Configuration Worksheet

Use this worksheet to identify the parameters necessary to configure SNA. Make copies of this
worksheet for each SNA configuration. See Appendix B, (fix cross reference) for SNA Server
configuration examples.

Local Node SNA Information

Connect:Direct Node Name:
LU Alias Name:

The LU Alias name is a user-defined name that references the LU name defined in the local SNA
network. This value can be the same as the actual LU name.

Get the following information from your local SNA administrator.

LU Name: Network Name:
Mode Name: Control Point Name:
Node ID:

Remote Node SNA Information

Connect:Direct Node Name:
LU Alias Name:

The LU Alias name is a user-defined name that references the LU name in the remote SNA network.
This value can be the same as the actual LU name. Obtain the following information from the SNA
administrator of the remote system.

LU Name: Network Name:
Control Point Name: Node ID:
Network Address:
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SNA Server/Host Configuration Worksheet

Complete the worksheet before you configure an SNA connection between the host and SNA
server. For each parameter listed, record the parameter value mapped between SNA and VTAM.
Use the alpha identifier in the first column to understand how the parameters are implemented in
the network map in the example following this table.

Windows/SNA Parameter Value Host/VTAM
[a] Local Connect:Direct node name i LOCAL.NODE
[b] Remote Connect:Direct node = ADJACENT.NODE
name =
[c] Mode f LOGMODE
[d] Session Limits i VTAM APPLID DSESSLIM
[e] Max RU i LOGMODE RU Size
[f] Server Netname i VTAMNETID (owner of PU)
[a] Server CPNAME i VTAM PU Name
[h] Connection CPNAME i VTAM SSCPNNAME
[i] Connection Netname i VTAM NETID (owner of PU)
[i] Connection LOCALBLOCKNO i VTAM PU DBLK
[k] Connection LOCALNODENO i VTAM PU IDNUM
[ Connection REMOTENETADDR i Remote Network Address
[m] Local LU Name (APPCLU) i VTAM LU Name (must be independent)
[n] APPCLU Netname i VTAM NETID (owner of PU)
[o] Remote Partner LU (APPCRLU) i VTAM APPLID
[p] APPRCLU Netname i VTAM NETID (owner of APPLID)
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z/OS Network Map Example

The following sample illustrates the use of the VTAM parameters (identified by the alpha
characters) in an z/OS network map:

LOCALNODE= ADJACENT .NODE= (

(node namel[b], (node namelal,
communications namel[o],, communications name[m],,
superuser password) LU6G2)

TCQ=(tcxdsn, tcgdsn)) PARSESS= (max[d], default)

ENVIRONMENT=NT
LOGMODE=1ogmode entry namel[c])

Refer to the platform-specific Connect:Direct Installation and Administration guides for network
map information on other host platforms.

Windows Network Map Example

The following sample illustrates SNA parameters (identified by alpha characters) in a Windows
network map:

CREATE SNA MODE Name (mode [c])
MAXRUsize (MaxRU [e]) MaxPacingSize (7) MaxNetSessLimit (8)

CREATE SNA COMMPATH Name (commpathname)

Transport (transport-type) Adapter (0) Address (000000000000)
NetId (netid[£f]) PUName () LUName (LUName [m])

ProfileName () LULocAddr (0) Mode (mode[c]) LUSessLimit (8)

CREATE REMOTENODE Name (remotenodename [b])

LRetry(10) LRetryTime (180) Sretry(10) SretryTime (10) SessPnodeMax (32)
SessSnodeMax (32) DefaultClass(l) RemoteOSEnv (z/0S) NetName (NetNamel[£f])
PartnerName (PartnerName[o]) TPName (NNV2DTF) Mode (mode[c])

CommPath (commpathname)
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Appendix B
VTAM 4.1 Example Definitions

This chapter provides sample SNA configuration and VTAM 4.1 definitions and instructions on
accessing SNA configuration listings.

Sample SNA Configuration

This section illustrates a sample SNA configuration used to connect to Connect:Direct for z/OS.

You provide the following SNA resource definitions during the Microsoft SNA configuration.
These values are derived from VTAM definitions supporting connections between Connect:Direct
for z/OS and Connect:Direct for Windows. Contact the VTAM administrator for the values you
need to specify during SNA configuration.

Windows Parameter Value z/0S

Remote LU Name = M1CDXY2B =APPLID

Local LU Name = M1RO1LUA =LU NAME
Network Name = CSDNET =NETID

Mode Name = NDM624K =MODEENT
Remote Control Point Name = CSDSAO01 =SSCPNAME
Local Control Point Name = M1RPUO1 =PU NAME
Local Connect:Direct Node = SS.DUB.USER1 =ADJACENT.NODE
Name

Remote Connect:Direct Node = CDNTO0001 =LOCAL.NODE
Name

Local Node ID = 0716200D =XID

Remote Network Address = 4000 7000 6200 =MAC Address
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VTAM 4.1 Sample Definitions

The following section contains definitions to use in configuring your SNA software. The relevant
resource name entries are in bold.

XCA Token Ring: Switched Net Definitions
The following sample represents the Switched Net PU definitions for an XCA attached Windows

SNA server.

KAk hkhkhkhkhkhkkhkhkhkhhkhhkhkhkkhkhkhhkhkhkhhkhkhkhkhkhkhhkhkhkhkhrkhhkhkhkhhkrkhhhhxkhx*k

* *

*XCA TR DEFINITION *

* *

* *

*CHANGE LOG *

* *

KAk Ak Ak kA hkhhkkhkhk kA Ak Ak hhhkkhhkhkhkhhhhkhkkhkhkhkhkhrhrhkhhkhkhkhkhkhhhhkhkhkkkkxx

M1RO1PU VBUILD TYPE=SWNET, X

MAXGRP=1, MAXIMUM NUMBER OF UNIQUE GRPNM X
MAXNO=1 MAXIMUM NUMBER OF UNIQUE DIALNO

*

* % %

M1RPUO1 PU ADDR=01, X
PUTYPE=2, X
ISTATUS=ACTIVE, X
DBLK=071, X
IDNUM=6200D, X
PASSLIM=8, X
DLOGMOD=NDM624K, X
MODETAB=DALLMTABRB, X
SSCPFM=USSSCS, X
USSTAB=LSUSSTAB, X
PACING=7, X
VPACING=7, X
DISCNT= (NO), X
MAXDATA=521, X
MAXPATH=2, X
MAXOQUT=8

*

M1RPTHOD PATH GRPNM=M1XG516D, X

DIALNO=0011111111111D DUMMY

*M1ROLUA LU LOCADDR=0, DLOGMODE=NDM6241C

*3270

*

M1R01LU2 LU LOCADDR=2, DLOGMOD=D4A3290

MI1R01LU3 LU LOCADDR=3,DLOGMOD=D4A3290

*

*LU 6.2 ILU

*
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XCA Token Ring: Independent LU Definition

Following is an illustration of the Independent LU definitions included as Cross Domain Resources:

VTAM 4.1 Sample Definitions

*

*

*

*

*

*

*

*

R I I S S S S S S S S S S S S I S S S S S S i S

VTAM 3.4 CDRSC DEFINITIONS FOR INDEPENDENT LU’S *

6.2 ILU DEFINITION - XCA TR

*CHANGE LOG:

M1RO1LUA CDRSC ISTATUS=ACTIVE,

ALSLIST=M1RPUO1,
MODETAB=DALLMTAB,
DLOGMOD=NDM624K,
RESSCB=5

M1IRO1LUB CDRSC ISTATUS=ACTIVE,

ALSLIST=M1RPUO1,
MODETAB=DALLMTAB,
DLOGMOD=NDM624K,
RESSCB=5

M1RO1LUC CDRSC ISTATUS=ACTIVE,

ALSLIST=M1RPUO1,
MODETAB=DALLMTAB,
DLOGMOD=NDM622K,
RESSCB=5

M1RO1LUD CDRSC ISTATUS=ACTIVE,

ALSLIST=M1RPUO1,
MODETAB=DALLMTAB,
DLOGMOD=NDM621K,
RESSCB=5

ACCESS

ADJ LINK STATION
LOGON MODE TABLE
LOGON MODE TABLE ENTRY
SESSION CONTROL BLOCKS

ADJ LINK STATION
LOGON MODE TABLE
LOGON MODE TABLE ENTRY
SESSION CONTROL BLOCKS

ADJ LINK STATION
LOGON MODE TABLE
LOGON MODE TABLE ENTRY
SESSION CONTROL BLOCKS

ADJ LINK STATION
LOGON MODE TABLE
LOGON MODE TABLE ENTRY
SESSION CONTROL BLOCKS

R

*

R R I i S I S S S S S S S S S S S S S S S S S i S

M1RO1CDS VBUILD TYPE=CDRSC

XXX X XXX XX X

XX X
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XCA Token Ring: Major Node Definition

The following sample illustrates the major node definitions for an XCA device:

R I I S S S S S S S S S S S S I S S S S S S i S

* *

* XCA MAJOR NODE *

* *

* CHANGE LOG: *

Ak Ak kA hkhkh kA Ak Ak hhkhkhkhkh bk hkhkhkhkhkhk bk hk bk hkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhkrhkhhk kA rhrkhkhhkhxkx*

M1XCA516 VBUILD TYPE=XCA XCA MAJOR NODE

*

M1XP5161 PORT MEDIUM=RING, TOKEN-RING X
SAPADDR=4, SERVICE ACCESS POINT ADDRESS X
ADAPNO=0, ADAPTER NUMBER X
CUADDR=516 CHANNEL UNIT ADDRESS

*

M1XG516D GROUP DIAL=YES, SWITCHED PERIPHERAL NODE X
CALL=IN, DIAL IN AS PER MCDATA X

ISTATUS=ACTIVE ACTIVATED AT GEN

*

M1XL516D LINE ANSWER=ON PU CAN DIAL IN

*
M1X516PD PU
*

* % %

Sample Connect:Direct APPLDEF

The following sample illustrates the application definitions for Connect:Direct for z/OS:

ZZAPPGLP VBUILD TYPE=APPL

Ahkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhkhhhkkhkhkhkkhkkk

* C:D z/0S TEST LU 6.2 ILU APPL DEFINITION *

* *

Ak hkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhkk

*

M1CDXY2B APPL ACBNAME=M1CDXY2B, VTAM APPLID X
APPC=YES, LU 6.2 CAPABLE X
AUTH= (ACQ, VPACE), VTAM AUTHORITY FOR THIS APP X
AUTOSES=10, # OF AUTO CONT WINNER ACTIVATES X
DDRAINL=ALLOW, DRAIN ALLOWED FOR CNOS 0 X
DLOGMOD=NDMLM1K,  DEFAULT MODE TABLE ENTRY X
DMINWNL=10, MIN CONT WINNER FOR LOCAL LU X
DMINWNR=10, MIN CONT WINNER FOR REMOTE LU X
DRESPL=ALLOW, APPL WILL DO SESSION DEACTIVATES X
DSESLIM=20, MAX # OF ALLOWED SESS FOR MODE X
EAS=509, APPROX # OF CONCURRENT SESSIONS X
MODETAB=DALLMTAB, MODE TABLE NAME X
VPACING=7 DEFAULT RECEIVE PACING VALUE

*
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Sample Connect:Direct MODEENTS (Mode Definitions)

The following sample illustrates the mode definition entries for an independent LU:

ERE R R Rk kb b b b b b I b b b b I I I I i i I I S S S S S I S S S S S S S S i S

* *
* LU 6.2 WITH 4K RU’S *
* *

ER R e R

NDM624K MODEENT LOGMODE=NDM624K, *
TYPE=1, *
COS=NDMCOS1,
FMPROF=X'13",
TSPROF=X’ 07",
PRIPROT=X'BO0’,
SECPROT=X'B0’,
PSNDPAC=X’04',
SRCVPAC=X'04',
SSNDPAC=X’04',
COMPROT=X'DOB1’,
RUSIZES=X’8989',
PSERVIC=X’060200000000000000000300" *

* 0123456789 1011

ER R R R )

R T T I

*

* *
* LU 6.2 WITH 2K RU’S *
* *

Ak hkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhkkhkhkhkhkk

NDM622K MODEENT LOGMODE=NDM622K, *
TYPE=1, *
COS=NDMCOS1,
FMPROF=X' 13",
TSPROF=X’ 07",
PRIPROT=X'BO0’,
PSNDPAC=X’04',
SRCVPAC=X'04',
SSNDPAC=X'04',
SECPROT=X'BO0’,
COMPROT=X'DOB1’,
RUSIZES=X'8888",
PSERVIC=X’060200000000000000000300"
* 0123456789 1011

Ahhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhhhhhhkhkhkhkhkhkhkhk

* ot

*

L T S S N

* *
* LU 6.2 WITH 1K RU’S *
* *

R R I I I S I S S S S S S S S S S I S S S S S S i S

NDM621K MODEENT LOGMODE=NDM621K, *
TYPE=1,
COS=NDMCOS1,
FMPROF=X'13',
TSPROF=X’ 07",
PRIPROT=X'B0’,
PSNDPAC=X' 04",
SRCVPAC=X’'04',
SSNDPAC=X' 04",
SECPROT=X'B0’,
COMPROT=X'DOB1’,
RUSIZES=X’8787',
PSERVIC=X’060200000000000000000300" *

* 0123456789 1011

L S S S

*
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Sample VTAM Start Options (ATCSTRxx)
The following sample represents the VTAM Start Option entries for NETID and SSCPNAME.

ERE R R Rk kb b b b b b I b b b b I I I I i i I I S S S S S I S S S S S S S S i S

* *
* z/0S VTAM START DEFINITION *
* *

ER R e R

HOSTSA=01,
NODETYPE=NN,
CONNTYPE=LEN,
CPCP=YES,
GWSSCP=YES,
NETID=CSDNET,
SSCPID=15015,
SSCPNAME=CSDSAO1,
LISTBKUP=DEFAULTS,
TNSTAT, NOCNSL, TIME=60,
PPOLOG=YES,
XNETALS=YES,
NCPBUFSZ=2048,
HOTIOTRM=50,
IOPURGE=5M,
MSGLEVEL=V4R1,
MAINTLVL=9311,
IOBUF= (750,320, 50,,30,100,3000),
CRPLBUF=(500,,0,,25,1),
LFBUF=(300,,0,,32,1),
LPBUF=(80,,0,,12,1),
SFBUF=(40,,0,,34,1),
SPBUF=(32,,0,,32,1),

(

(

bed

PO X X X X X XK X X XX X X X X X X XXX

BSBUF=(600,,0,,25,50),
XDBUF=(55,,0,,5,1)

Sample Connect:Direct for z/OS Network Map Entries

The following sample illustrates Connect:Direct for z/OS network map entries for Windows SNA
software running Connect:Direct for Windows:

R R kb e I I I I I I i I I I I i i S S S S S S S S S S S S I S S S S S S S S

* *
* Connect:Direct NETWORK MAP *
* *

R E R Rk Ik kb h e b b I b b I b I i I I I b I I I I i S S S S S S S S S S
* *

KA KKK KR KRR KRR KR AR KRR KA A AR Ik hkhhhkhhhkhkhkhkhhkhhkhkhhhkhkhkkhkhkhkhhhhhhhhhkhkhhhkhkhkhkxkx*x

* LOCAL NODE *
dAhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhhhhhhhhhkhkkhkhkhkhkhkhkhkhk
LOCAL.NODE = ((SS.DUB.USERl MI1CDXX2B,, SUPERUSR) -
TCQ= (USER1.R210.TCX -
USER1.R210.TCQ) )
*
ADJACENT.NODE = (PARSESS = (10 2) -

(CDNT0001, M1RO1LUA, LU62) -
ENVIRONMENT=NT -
LOGMODE=NDM624K )
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Accessing SNA Server Configuration Listing

Use the following Windows SNA Server command to display the configuration and redirect the
information to a file:

snacfg /print>filename

The following sample illustrates the Microsoft SNA server configuration listing for a configured
Windows server using the values listed in the VTAM Sample Definitions:

MODE #INTER /ADD
/SESSIONLIM: 8
/CONWIN: 4
/CONLOSE: 0
/RUTOACT: 0
/AUTOPARTNER: No
/HIGHPRIORITY:Yes
/PACESENDCNT : 7
/PACERECVCNT : 7
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT: "Interactive"

MODE #INTERSC /ADD
/SESSIONLIM: 8
/CONWIN: 4
/CONLOSE: 0
/RUTOACT: 0
/AUTOPARTNER: No
/HIGHPRIORITY:Yes
/PACESENDCNT : 7
/PACERECVCNT : 7
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT:"Interactive"

MODE #BATCH /ADD
/SESSIONLIM: 8
/CONWIN: 4
/CONLOSE: 0
/RUTOACT: 0
/AUTOPARTNER: No
/HIGHPRIORITY :No
/PACESENDCNT : 3
/PACERECVCNT: 3
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT : "Batch" \

P P P P P A S T S

MODE #BATCHSC /ADD
/SESSIONLIM: 8
/CONWIN:4
/CONLOSE: 0
/RUTOACT: 0
/AUTOPARTNER: No
/HIGHPRIORITY :No
/PACESENDCNT : 3
/PACERECVCNT : 3
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT: "Batch" \

P S P P

MODE BLANK /ADD
/SESSIONLIM: 8
/CONWIN: 4
/CONLOSE: 0
/RUTOACT: 0
/AUTOPARTNER: No
/HIGHPRIORITY :No
/PACESENDCNT : 3
/PACERECVCNT : 3
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT:"8 Blank chars"

P S

Continued
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MODE QPCSUPP /ADD
/SESSIONLIM: 64
/CONWIN:32
/CONLOSE: 0
/AUTOACT: 0
/AUTOPARTNER: Yes
/HIGHPRIORITY:Yes
/PACESENDCNT: 7
/PACERECVCNT: 7
/MAXSENDRU:1024
/MAXRECVRU:1024
/MAXSENDRU:1024
/MAXSENDRU:1024
/COMMENT:"5250 Mode"

MODE NDM624K /ADD
/SESSIONLIM: 20
/CONWIN:10
/CONLOSE:10
/AUTOACT: 0
/AUTOPARTNER:No
/HIGHPRIORITY :No
/PACESENDCNT: 7
/PACERECVCNT: 7
/MAXSENDRU:4096
/MAXRECVRU:4096
/MAXSENDRU:4096
/MAXSENDRU:4096
/COMMENT:" "

SERVER CSD-PUBS /ADD
/CPNAME :M1RPUO1
/NETNAME : CSDNET
/COMMENT : ""

LINK SNADLCl /ADD
/SERVER:CSD-PUBS
/LINKTYPE:Token

CONNECTION TOKEN1 /ADD
/SERVER:CSD-PUBS
/COMMENT:"802.2 Connection"
/ACTIVATION:OnServerStartup
/CALLDIRECTION:Both
/LOCALBLOCKNO: 071
/LOCALNODENO: 6200D
/CPNAME : CSDSAO01
/NETNAME : CSDNET
/REMOTEBLOCKNO :
/REMOTENODENO :
/LINKSERVICE: SNADLC1
/REMOTEEND: Host
/CONNTYPE:802.2
/XIDTYPE:Format3
/REMOTENETADDR: 400070006200
/REMOTESAPADDR: 4

/MAXBTULEN:1929
/RECEIVEACKTHRESH: 2
/NAKSENDLIMIT:8
/RETRYLIMIT:10
/XIDRETRIES:3
/T1TIMEOUT:Default
/T2TIMEOUT:Default
/TITIMEOUT:Default
/ACTIVATEDELAY:Default
/ACTIVATERETRYLIMIT:None

APPCRLU M1CDXY2B /ADD
/CONNECTION: TOKENL
/NETNAME : CSDNET
/LUNAME : M1CDXY2B
/COMMENT : ""
/UNINTERPNAME : M1CDXY2B
/AUTOPARTNER:No
/PARALLELSESS:Yes

P P

P e P S g

P g

P

Continued
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APPCLLU MIRO1LUA /ADD
/SERVER: CSD-NTSNAL
/LUNUMBER: 0
/NETNAME : CSDNET
/LUNAME : MIRO1LUA
/COMMENT : " "
/AUTOPARTNER: No
/DEFAULTPOOL : No
/TPTIMEOUT: 60

P

APPCLLU MI1RO1LUA
/ADDPARTNER :M1CDXY2B,NDM624K , TOKEN1

APPCLLU M1RO1LUB /ADD
/SERVER:CSD-NTSNAL
/LUNUMBER: 0
/NETNAME : CSDNET
/LUNAME : MIRO1LUB
/COMMENT : ""
/AUTOPARTNER:No
/DEFAULTPOOL : No
/TPTIMEOUT: 60

P

APPCLLU M1RO1LUB
/ADDPARTNER :M1CDXX2B ,NDM624K , TOKEN1

USER USER1 /ADD
/DOMAIN:CSD-NTSNAL
/COMMENT : ""

e

USER USER1
/INSERT:M1RO1LU2

—

USER USERL \
/INSERT:M1R0O1LU3 \

DIAGNOSTIC \
/AUDITLEVEL:10 \

Accessing Communications Server Configuration Listing

The SNA configuration listing for the IBM Communications Server is stored in a file with an
extension of acg. The name for this file is defined when you install the Communications Server.
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Glossary

A

Adjacent Node

An entry in the network map that defines a Connect:Direct node with which the local Connect:Direct
node can communicate. The adjacent node is also referred to as a remote node.

Advanced Program-To-Program Communication (APPC)

The general facility characterizing the LU6.2 architecture and its various implementations in products.

Application Program Interface (API)

A Connect:Direct component that accepts commands and places them in an executable format.

C

Checkpoint Restart

Feature that eliminates the need to retransmit an entire file in the event of a transmission failure. If a
copy procedure is interrupted, Connect:Direct restarts that copy at the last checkpoint.

Commands

Initiate and monitor activity within the Connect:Direct system.

Configuration Registry

A database of configuration information central to Windows operation. The Registry is the storage
location for configuration settings for Windows applications. The Registry centralizes all
Windows settings and provides security and control over system, security, and user account
settings.
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Domain Name Service (DNS)

A distributed database that provides a hierarchical naming system for identifying Internet hosts.

L

Local Node Record

The base record in a parameters file that defines the Connect:Direct server. It includes the most
commonly used settings at a site and is the central node through which all communication is
filtered. Depending upon how each remote node record is configured, trading partner node
records can use settings that are defined in the local node record.

Logical Unit (LU) 6.2

A type of logical unit that supports general communication between programs in a distributed
processing environment. LU6.2 is characterized by (a) a peer relationship between session
partners, (b) efficient utilization of a session for multiple transactions, (¢) comprehensive
end-to-end error processing, and (d) a generic application program interface (API) consisting
of structured verbs that are mapped into a product implementation.

N

Network Map (Netmap)

The file that identifies all valid Connect:Direct nodes in a network including a local node record and
a remote node record for each trading partner. The network map also defines the rules or
protocols used by each node when communicating with the local Connect:Direct node.

Node

Any site in a network from which information distribution can be initiated.
New Technology File System (NTFS)

A system that uses fixed disks to organize data. NTFS treats files as objects with user and system
defined attributes.
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Primary Node (PNODE)

The node that submits the Connect:Direct Process to the secondary node (SNODE). In every
communication, you must have a PNODE and an SNODE.

Process

A series of statements that initiate Connect:Direct activity, such as copying files and running jobs.

Process Statements

Instructions for transferring files, running operating system jobs, executing programs, or submitting
other Connect:Direct Processes. They are used to build a Connect:Direct Process.

R

Registry
See Configuration Registry.

Remote Node

An entry in the network map that defines a Connect:Direct node with which the local
Connect:Direct node can communicate. The remote node is also referred to as an adjacent node.

Retry Interval

The interval at which retries are performed as a part of the checkpoint-restart feature.

S

Secondary Node (SNODE)

The Connect:Direct node that interacts with the primary node (PNODE) during Connect:Direct
Process execution and is the noncontrolling node. Every Process has one secondary node and
one primary node.

Statistics File

Holds Connect:Direct statistics records that document the history of a Process.
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Statistics Facility

Records Connect:Direct activities.

Systems Network Architecture (SNA)

The description of the logical structure, formats, protocols, and operational sequences for
transmitting information units through, and controlling the configuration and operation of,
networks.

Transmission Control Queue (TCQ)

Holds information about Connect:Direct Processes that are currently executing or scheduled to
execute in the future.
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Communications Server Configuration Listing
accessing 49

component
install additional 24
remove 24
repair corrupted 24

configure
database 16
firewall navigation 27
host-based partner 16
peer-based partner 16
sample SNA configuration 41
silent install 19
SNA environment 15
SNA tool 16
TCP/IP connectivity 15
Windows user privileges 14

custom install 22

custom account
assign 15
Enterprise Admin group 15
full permissions to Secure+ directory 15
identify 15
privileges 14

D

database configure 16

definitions, sample SNA 42

E

Execution queue 8
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firewall
configure navigation 27
set parameters 26

H

Hold queue 8

INI file, automated installation 17

install 19
additional component 24
automate 17
completing typical 21
components 19
custom 22
remove component 24
repair component 24
silent configuration 19
worksheets 17, 35

L

license key 20
log on, using custom account 15

Logical queues in TCQ 8

P

parameter
API port number 31
defined in CD_SRVR.INI file 30
enables authentication 32
enabling SNMP 31
enabling SNMP event log 31
firewall support 26
flags current version for uninstall 30
host port number 31
host TCP/IP address 31
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parameter (continued) s
identifies IP address of SMTP host 31
identifies port of SMTP host 31 session
identifies sender email address 32 initiation
identifies user ID to authenticate server 32 primary control 5
identifies user password to authenticate server 32 SNA

identifying SNA connectivity 31 configuration tool 16
installation type 30 configure 15, 23
IP address of host server 31 host-based partner 16
local LU name 31
local node
tep.sre.ports 26
tep.sre.ports.list.iterations 27
local node name 30
notification type 31 SNMP
path and file names to user authority file 32 configuring support 23
path and network map file names 32
path name to license file 31

peer-based partner 16
sample configuration 41

SNA server configuration listing
accessing command and sample 47

Software Developer Kit (SDK) 19

register client IP address to AD 31 Sterling Control Center 9
SNA mode name 31

SNA network ID 31 T
SQL Server administrator ID 32

SQL Server administrator password 32 tcp.sre.ports

tep.src.ports 26 parameter 26

tep.sre.ports.list.iterations 26
upgrade version 30
valid SQL Server name 32

tep.sre.ports.list.iterations
parameter 27

TCP/IP

permanent license key 20 configure 15

Primary control, initiating a node 5 connectivity 15
privileges TCQ
be a member of the Local Administrator Group 15 description 9

custom account 14
full permissions to Secure+ directory 15

temporary license key 20

log on as service 14 Timer
replace a process level token 15 queue 8
Process U
controlling execution 8
definition 7 uninstall 25
queue Wait queue 8
Hold 8 ) o .
TCQ 8 Windows user privileges configuration 14
Timer 8
Wait 8

R

Register with Active Directory 23
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